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Narrative Reporting Overview
The Narrative Reporting dashboard streamlines the contextual analysis, review, and narrative 

capture process. Key benefits of Narrative Reporting include: 

Live Narrative Reporting
Analyze and search live, validated OneStream data and reporting content while capturing 

narratives to streamline the contextual analysis, review, and narrative capture process.

Reduce Risk and Reporting Errors
Leverage the same interface, workflows, validations, and controls to ensure trusted and auditable 

results to eliminate the risk and cost of traditional copy, paste, and duplicate across multiple tools 

and solutions.

Centralize and Streamline Assembly of Narrative Books
Centralize the creation of narrative books in OneStream, organizing all report content, live 

analysis, and collaborative capture of narratives to effectively analyze and communicate 

corporate performance.

Accelerate the Narrative Reporting Process
Leverage all existing OneStream reporting artifacts, import reporting content to quickly structure 

narrative books, copy from prior periods, and embed in the close, planning, and other workflow 

processes with approvals, saving time, driving efficiency and accelerating the narrative reporting 

process.
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Trusted and Familiar Interface
Leverage the same OneStream interface and trusted reporting content along with the familiarity of 

Microsoft Office to capture narratives and create rich, formatted and collaborative narrative books. 

Intuitively combine rich text documents, text, Word Documents, Excel sheets, and PDF 

documents, all-in-one solution, to easily capture narrative content and deliver formatted narrative 

books.
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Setup & Installation
This section contains important details related to the planning, configuring, and installation of your 

solution. Before you install the solution, familiarize yourself with these details.

See OneStream Solution Modification Considerations.

Dependencies

Component Description

OneStream 9.1.0 or later Minimum OneStream Platform version required to install this 

version of Narrative Reporting.

IMPORTANT: Before installing Navigation Center version 9.x or later, first install 

Narrative Reporting version 9.x. This ensures existing data and books are migrated.

Create the OneStream Development 
Application

 1. Ensure all the OneStream artifacts relating to Narrative Reporting such as workflow profiles 

and entities are in the Production application.

 2. Copy your Production application to your Development environment and rename it. Use the 

development version for your Narrative Reporting solution.
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Select the Narrative Reporting Development 
Location
Before installation, decide whether to build the solution directly in the Production OneStream 

application or in a separate Development OneStream application. This section provides some key 

considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a 

Production application is that you will not have to migrate the resulting work from a Development 

application. However, there are intrinsic risks when making design changes to an application used 

in a Production capacity and it is not advised.

NOTE: OneStream strongly recommends that you implement the solution in the 

Development environment with a fresh copy of the Production application before starting 

work.

Development OneStream Application: As a best practice, use the Development OneStream 

application to build the solution.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and 

change data in the additional database tables. If other OneStream Solutions (such as Specialty 

Planning) are already in the application, these adjustments may already exist.

See Solution Database Migration Advice.
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Configure the OneStream Application Server

Be sure that the security group settings include the users who work on and set up the solution 

before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important to keep 

the group names generic.

 1. Start the OneStream Server Configuration Utility as an Administrator.

 2. Click Open Application Server Configuration File > Database.

 3. Edit the following OneStream Database Server properties:

 l Access Group for Ancillary Tables: Select a group that includes those who will access 

records.

 l Can Create Ancillary Tables: True

 l Can Edit Ancillary Table Data: True

 l Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.

 l Table Creation Group for Ancillary Tables: Select a group who can create tables.
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 4. Restart Internet Information Server.

Narrative Reporting Guide 6

Setup & Installation



Install Narrative Reporting
 1. In  OneStream Solution Exchange, go to OneStreamSolutions and select the Narrative 

Reporting tile.

 2. On the Narrative Reportingpage, from the Platform Version drop-down menu, select the 

appropriate OneStreamPlatform Version.

 3. In the Solution Version drop-down menu, select the most recent version. 

 4. Click the Download button.

 5. Log in to OneStream.

 6. On the Application tab, click Tools>  Load/Extract.

 7. On the Load tab, locate the solution package using the Select File buttons, and click the 

Open button.

 8. When the solution file name displays, click the Load button.

 9. Click the Close button to complete the installation.
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Set Up Narrative Reporting
The first time you run Narrative Reporting, a guided table setup process begins.

 1. In OneStream, click OnePlace > Dashboards > Narrative Reporting > Narrative 
Reporting.

Create Tables
 1. Click Step 1: Setup Tables

This step may be necessary when upgrading even if tables are already present. Narrative 

Reporting does not drop existing tables but modifies table structures and adds new ones if 

necessary.
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 2. When setup is complete, click Step 2: Launch Solution to open Narrative Reporting.

Package Contents
The Dashboard Maintenance Unit provides the user interface for Narrative Reporting and 

includes the required dashboard groups, components, data adapters, parameters, and files. The 

following business rules are included:

 l NRR_Helper Queries: This is a dashboard dataset business rule. This rule provides 

various dashboard dataset helper functions to generate the reports for Narrative Reporting.

 l NRR_SolutionHelper: This is a dashboard extender business rule that provides various 

helper functions for Narrative Reporting. These helper functions include management of 

the solution setup, configuration settings, and management reporting details.

 l NRR_ParamHelper: This is an XFBR string business rule with conditional parameter 

helper and security access functions for Narrative Reporting.

 l NRR_ProcessAndZip: This rule processes any document under a selected tree item and 

packages the files into a .zip file. Security access determines which files can be processed 

for a user.
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 l NRR_MergeDocs: This rule processes any document under a selected tree item and 

packages the files into a single document. Security access determines which files can be 

processed for a user.

The following Data Management Sequences and Steps are created and can be used with their 

related business rules. Running these processes through a Data Management Sequence allows 

them to run in the background while the user continues to work.
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Settings
The Settings page contains three menus that guide administration including Book 

Management, Security Management, and Uninstall options.

Security Management
Administrators can use the Security Management settings to determine which groups can 

manage different parts of the Narrative Reporting solution. The following options can be set:

 l Security Role [Manage Narrative]: Determines which security group can manage 

narrative books

 l Retained Version Threshold: Determines the quantity of retained versions for documents 

within Narrative Reporting

Book Management
Administrators and book owners can create and manage report books using the Narrative Books 

page in Settings > Book Management.  When managing books, follow these guidelines: 
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 l Book and section names can be repeated.

 l Each book can contain multiple sections.

 l A section must only be assigned to one book.

 l Two levels are supported in the navigation tree. For example, a section can be placed 

under another section.

 l Each section can contain multiple documents.

 l A document must only be assigned to one section.

 l Document names must be unique in a single book, but they can be repeated across books.

The Books grid displays the following information: 

 l Name (required): The name of the book.

 l Description: The description of the book.

NOTE: Book names and descriptions can be duplicated. The maximum number of 

characters is  500.

 l Display Order (required): The order the book is displayed in the grid and in the Narrative 

Reporting home screen book drop-down menu.

 l Owner Group: The security group that owns the book and all documents within the book. 

The default is Everyone.
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 l Viewer Group: The security group that can view the book and all documents in the book. 

The default is Everyone.

 l Approver Group: The security group that can approve the book and all documents in the 

book. The default is Everyone.

 l Cube View Profile: Sets the Cube View Profile for the book. Cube View Profiles determine 

which Cube View Groups display for users when they are inserting Cube Views into their 

documents using the Add Content wizard from the Artifacts tab on the Details pane.

 l Enable: Determines whether the book is displayed to users in the drop-down menu above 

the navigation tree in Narrative Reporting. The Enable checkbox is selected by default. To 

remove the book from the drop-down menu, clear the Enable checkbox.

 l Created By: The user who created the book. User details are automatically added when a 

book is created.

 l Created On: The date the book was created. This field automatically populates when a 

book is created.

 l Parameters: A field that can be referenced in a document to ensure data accuracy. Only 

custom, literal parameters you want to use in your books need to be entered using this 

column. Substitution variables and OneStream Workspace parameters can be entered 

directly into your narrative document using Quick Parts without creating it and saving it to 

book management.

Example: Parameter Name = Parameter Value

NOTE: Multiple parameters can be entered in this field separated by commas. If a 

comma is included in the value of a parameter, enclose the value in brackets. For 

example, Reporting Date = [Month Day, Year].
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Narrative Books Management

Manage, copy, or delete a book by selecting it from the grid and clicking the respective button.

 l Manage: This opens the Sections and Documents page where you can edit the structure of 

the book. See Sections and Documents.

 l Copy: This copies the selected book and associated documents.

NOTE: All statuses for the copied documents are set to checked-in during the 

copy process.

 l Delete: This permanently deletes the book and all associated documents, regardless of 

statuses.

Sections and Documents

Administrators and book owners can manage the structure of narrative books using the Sections 

and Documents page. 

 1. Create the structure of the book in the Sections grid . This structure is mirrored in the main 

display through the navigation tree. 

 2. Upload documents to the database and create your narrative book in the Documents grid.
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 1. The Sections grid  displays the sections in a narrative book and includes the following 

information:

 l Section Name: The name of the section.

 l Display Order: The order the section is displayed in the book and in the navigation 

tree. When the number ends in a zero after the decimal place, such as 1.0 or 2.0, a 

new section indicator  is automatically added to indicate a top-level section. The 

format must be ####.####, including the leading zeros.

 2. The Documents grid  displays the documents in each section and contains the following 

information:

 l Document Name: The name of the document. Names must be unique in a single 

book, but they can be repeated across books.

 l Description: The description of the document.

 l Display Order: The order in which the document is displayed within the section and 

in the navigation tree. The Display Order cannot be zero.
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 l Enable: This determines whether the document displays in the navigation tree after a 

book is selected. The Enable checkbox is selected by default. To remove the 

document from the navigation tree, clear the Enable checkbox.

 l Status: Displays the current status of a document.

 l Preparer Group (optional): The security group that can edit and submit the 

document for approval. This security group is in addition to the Book Owners group. 

The default is Everyone.

 l Viewer Group (optional): The security group that can view the document. 

This security group is in addition to the Viewer group and can be left blank. The 

default is Everyone.

 l Approver Group (optional): The security group who can approve the document. 

This security group is in addition to the Approver group. The default is Everyone.

 l Source File Name: The name of the source file including the file extension.

 l Imported: This indicates if the file has been imported into the table.

 l Page Break: When enabled, this setting determines if a page break will be added 

after the document when the Merge function is used. When not enabled, the contents 

of merged documents will display without additional spacing or paragraph breaks. 

 l Mode: Determines how the document can be opened for editing. Document modes 

include the following options: 

 o OneStream Editor: Users can edit and refresh documents dynamically using 

XF docs and document variables directly in Text Editor and Spreadsheet.  See 

"Creating an Extensible Document in Text Editor" in the Design and Reference 

Guide.
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 o Office (Processed): Users can edit and refresh documents dynamically using 

XF docs and document variables directly in a Microsoft Office application.  See 

"Creating an Extensible Document in Microsoft Word" in the Design and 

Reference Guide.

 o Office: Users can check out a document to a Microsoft application, edit it, and 

check it back in so all users can see the latest changes. See Work with 

Documents.

 l Parameters: A field that can be referenced in a document to ensure data accuracy. 

Only custom, literal parameters you want to use in your documents need to be 

entered using this column. Substitution variables and OneStream Workspace 

parameters can be entered directly into your narrative document using Quick Parts 

without creating it and saving it to book management.

Example: Parameter Name = Parameter Value

NOTE: Multiple parameters can be entered in this field separated by 

commas. If a comma is included in the value of a parameter, enclose the 

value in brackets. For example, Reporting Date = [Month Day, Year].

 3. Reset Status: On the Sections and Documents page, click this button to set the selected 

document back to checked-in status.

Create the Navigation Tree Structure

As an administrator or book owner, define the structure of a book by adding sections and 

documents individually or using the Import Template feature.
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Sample Template

Click the Template button to upload a template containing the narrative book structure and create 

the sections and documents relationship. The template should be a comma-separated values 

(.csv) file. Click the  Download Template button to access a sample template.

Before importing, consider the following information: 

 l The display order is automatically generated based on the row order in the .csv file.

 l Import templates will replace the existing grid data.

Import the .csv file using the following fields: 

 l Type: This describes the structure of the book. Enter Root, Section, or Document.

 o Root: This defines the top level of a section.

IMPORTANT: The template should always start with a Root type.

 o Section: This defines sections of a book.

 o Document: This defines the document.

 l Name (required): The name of the section or document.
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 l Description: The description of the document. Description is optional for Section type. 

 l Preparer Group: The security group that can edit and submit the document for approval. 

The default is Everyone.

 l Viewer Group: The security group that can view the document. The default is Everyone.

 l Approver Group: The security group that can approve the document. The default is 

Everyone.

 l Enable: True or False field indicating if a document will display in the navigation tree. The 

default value is True when the field is left blank.

 l Source File Name: The unique name of the source file including the file extension.

 l Mode: Determines how the document can be opened for editing. See Mode in Document 

Grid.

 l Page Break: When enabled, this setting determines if a page break will be added after the 

document when the Merge function is used. When not enabled, the contents of merged 

documents will display without additional spacing or paragraph breaks. 

 l Parameters (optional): A field that can be referenced in a document to ensure data 

accuracy.

Documents

After you define a book structure, you can import individual documents or a .zip file using the 

Documents icon. Supported file types include Microsoft Word, Excel, and PowerPoint documents. 

Before importing, make sure the file has been saved and closed. 

 1. From Sections and Documents, select a section.

 2. Click the Documents button.

 3. Use File Explorer to select your file. Click the Open button.
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Export Book Content

Click the Export Book button to extract all book and document details into a .csv file. This file 

enables you to quickly import your narrative reporting details across environments and 

applications.

Uninstall
Use the Uninstall feature to uninstall the Narrative Reporting interface or the entire solution. If 

done as part of an upgrade, any modifications performed on standard Narrative Reporting objects 

are removed.

 1. On the Settings page, click the Uninstall tile.

 2. On the Uninstall page, select Uninstall UI or Uninstall Full.

 l Use the Uninstall UI button to remove Narrative Reporting, including related 

dashboards and business rules, but retain the database and related tables.

NOTE: For some releases, perform this step before accepting a new 

solution version as some of the dashboards or other objects may have 

changed. Choose this option to update Narrative Reporting without 

removing the data tables. The Release Notes indicate if a reinstall over the 

existing installation is supported.

 l Use the Uninstall Full button to remove all related data tables, data, and Narrative 

Reporting dashboards and business rules. Choose this option to completely uninstall 

Narrative Reporting or to perform an upgrade that is so significant in its changes to 

the data tables that this method is required.
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CAUTION: Uninstall procedures are irreversible.

 3. On the Confirm dialog box, click the Uninstall button to proceed.
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Home
Narrative Reporting enables you to analyze and search live, validated OneStream data and 

reporting content while capturing narratives to streamline the contextual analysis, review, and 

narrative capture process.

Use the dashboard to view the structure of a book using the Tree Navigation. Only documents you 

have access to display in the Tree Navigation. Select documents within the book to preview, 

check out, submit, and approve during the reporting cycle.

 1. Close Pane Icon: Used to close the Tree Navigation pane which increases the viewing 

area of a selected document. To reopen the Tree Navigation pane, click  the  button. 

 2. Narrative Books: Drop-down list of enabled books. List selection varies by security group 

assigned to the user and book.
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 3. Filter: Search for documents or a section within the selected book.

 4. Tree Navigation: Visual hierarchy displaying sections and documents of the selected 

book.

 5. Publish: Download finalized versions of books and documents. See Publish Documents.

 6. Mode: Drop-down used to select your preferred editing application. See Sections and 

Documents.

 7. Main Display: Viewing area for documents selected using the Tree Navigation. Displayed 

information includes: 

 l Document Name: The name of the document.

 l Document Status: The status of the document. See Document Statuses.

 l Last modified date and time: Date and time of the most recent changes.

 l Document file type: Source file type, such as Microsoft Word, Microsoft Excel, or 

others.

 l Preview button: Enables you to preview the document.

 l Actions button: Enables you to perform actions based on the current status. 

Buttons shown to users are based on permissions and may include:

 o Check-Out

 o Undo Check-Out

 o Check-In

 o Submit

 o Approve

 o Return
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 8. Details Pane Toggle: Expand the details pane to view document status, activity, and 

versioning. See Details Pane.
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Document Statuses
Document status is represented by an icon in the Tree Navigation and in the Main Display area. 

Depending on the document status and the security group of the book and document, you will see 

different action buttons in the Main Display area.

Status Status Defined Tree 
Navigation 
Icon

Main 
Display 
Icon

Checked-In Document is available to check-out for 

edits.

Checked-Out Document is currently checked-out by 

another user.

Submitted Document has submitted for approval by 

a user.
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Status Status Defined Tree 
Navigation 
Icon

Main 
Display 
Icon

Returned Approver has sent the document back to 

the user who submitted it for additional 

edits .

Approved Document has been reviewed and 

accepted by the Approver.
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Document Summaries
All Narrative Reporting users can view summaries of all the documents in the book or sections 

within the book, giving them the ability to see document progress. Select any section or the 

topmost folder to view the summaries for the sections or complete book.

NOTE: All documents within a section or book are included in summary counts. This 

means, depending on your security access, what you see in the tree navigation may 

differ from the total counts shown on the cards.

The following summary information is displayed: 
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 1. Cards: Shows document statuses within the section or book selected.

NOTE: Click any tile to filter the summary grid.

 l Not started: Documents that have imported to a book so the default status is 

checked-in, but the document has never been checked-out.

 l Started: Documents currently in a checked-out status or in a checked-in status but 

have been previously checked-out.

 l Submitted: - Documents that have been submitted for review and their status is 

Submitted.

 l Returned: Documents that have been reviewed and returned to the user who 

submitted the document for approval, setting the status to Returned.

 l Approved: Documents that have been reviewed and accepted so their status is 

Approved.

 2. Summary Grid: An overview of the documents within the section or book selected.

 l Section: Name of the section.

 l Description: An overview of the document. If the description field for the document is 

left empty by an administrator or book owner, the document name will populate.

 l Status: Current document status.

 l Preparer: User who prepares the document. If the Document Preparer field is left 

empty by an administrator or book owner, the Book Owner name will appear.

 l Approver: User who can approve the document. If the Approver field is left empty by 

an administrator or book owner, the Book Approver name will appear.

 l Last Updated: Date and time the document was last modified.
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Previewing Documents
With proper access, a document can be previewed in any status. To preview a document, follow 

these steps: 

 1. From Narrative Reporting, select a book from the drop-down menu.

 2. Use the Tree Navigation or filter to locate the document, and select it.

 3. In the Main Display area, click the PREVIEW button.

 4. To increase your viewing area, click the Close Pane button on the Tree Navigation pane.. 

NOTE: Use the  icon to expand the Tree Navigation. 
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Work with Documents
You must check out a document to make edits to it. Checking out a document prevents other 

users from making changes to it while you are accessing it. You can check out multiple 

documents at once. When done, you must check the document back in for others to view the 

changes.

Document Check Out
Make changes to a document in a narrative book by checking the document out.

 1. From the Home page, select a book from the drop-down.

 2. Use the Tree Navigation or filter to locate the document and select it.

 3. Optional: Change the Mode drop-down to your preferred editing application.

 4. From the Main Display, click the Check Out button to open the document. Alternatively, 

click the Preview button and then click the Check In button.

NOTE: After opening, the status of the document changes to checked-out and 

cannot be edited by another user.

 5. Edit the document and click the Save & Refresh button to save and refresh your 

document.
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Undo Document Check Out
If you check out a document by mistake, click the Undo Check Out button to immediately check 

the document back in without committing any changes. Administrators or Book Owners can undo 

a check out for another user.

Document Check In
After a document is checked out and changes have been made, check the document in to upload 

the changes. Only the user who has checked-out the document can perform this action.

Microsoft Office

If you edited the document using a Microsoft application, such as Microsoft Word, Excel, or 

PowerPoint: 

 1. Save the document.

 2. Navigate to the OneStream application and click the Check In button.

 3. From File Explorer, select the document and click Open.

NOTE: The file name checked-in must match the file name of the document 

checked-out.
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OneStream Editor

If edits were made using OneStream Editor, including Text Editor or Spreadsheet: 

 1. Save all changes.

 2. Click the Check In button.

NOTE: Use the Artifacts tab in the Details Pane to edit all your artifacts directly in 

OneStream or to quickly add new artifacts. See Details Pane.
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Submit a Document
When a document is ready for final approval, from the Main Display, click the Submit button. The 

document is locked from further changes.

Approve or Return a Document
After a document is submitted and reviewed by the user indicated in the Approver Group, the user 

can choose from two options:

 l Return the document to the user by clicking the Return button. Document status changes 

to Checked-In and becomes available for users to make additional changes.

 l Approve the document by clicking the Approve button. Document status changes to 

Approved and additional edits cannot be made.
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Details Pane

Click this button  to open the Details pane.

Click this button to close the Details pane.
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Activity Tab

Select the Activity tab to view the status of the document displayed using a visual approval flow. 

Completed steps display in green while pending steps display in blue. 

Additionally, view the Activity Log. The log displays all activities for the selected document. 

Logged actions include when a book is created or when a document is updated with one of the 

following activities: 
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 l Created

 l Saved

 l Previewed

 l Checked Out

 l Returned using the Undo Check Out button

 l Checked In

 l Submitted

 l Returned

 l Approved

The log also displays the date and time of the modification using the system date and time of the 

user. The name of the user who performed the activiey is also logged. 

Versions Tab
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Narrative Reporting stores previous versions of a document. See Security Management. 

Select the Versions tab to view the version history of the document.

Version details include the following information: 

 l TimeStamp: Date and time the document was checked in

 l Username: Name of user who checked in the document

Click the Download button to download previous versions of the document.

Artifacts Tab
Use the Artifacts tab to quickly view and edit all artifacts in the selected document. Artifacts 

displayed include document variables, parameters, and extensible documents.
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Open Artifacts
 1. Open the Details Pane.

 2. Go to the Artifacts tab, and select an artifact.

 3. Click the Open button. 

If the artifact is editable, make changes directly in OneStream. If the artifact is viewable, 

review the details. These artifacts are viewable: 

 l Cube Views

 l Charts

 l Excel Sheets

 l Excel Named Ranges

 l Parameters 
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NOTE: Parameter details include the name of the parameter, the string 

value, and the resolved value. To create a new or add an existing parameter 

to your document or book, see Book Management for administrators or 

Insert Parameter for all other users.

 4. If you made changes, save and refresh. When you refresh the document, your changes are 

incorporated.

Refresh Artifacts

Click the Refresh button to refresh the list of artifacts.

Add Content

You can add content to your narrative document in these ways:

 l Artifacts wizard

 l Manually using Quick Parts or parameter fields in Book Management

NOTE: OneStream recommends using the Windows Application when adding 

new content into narrative documents.

Dynamic Wizard

Click this button to embed extensible content, such as charts and spreadsheets, and to 

create and insert document or book parameters using the Artifacts wizard.

To add a new artifact, open the Details Pane, go to the Artifacts tab, and click the Add button to 

be guided through the Artifacts wizard to add the following types of content: 
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 l Insert Content Using Document Variables

 l Insert Content Using Office Image

 l Reference Book Content

 l Insert Parameter

 l Create Parameters

Manual Content Insertion

The following types of extensible content are supported outside of the Artifacts wizard:

 l BI Viewer Chart Components

 l XFCell References

 l XFBRs

See Supported Extensible Content to learn more. 

Insert Content Using Document Variables

Follow these steps in the wizard to insert content using a Microsoft Word document or OneStream 

Text Editor for Extensible Documents.
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 1. In the Artifact Selection section, from the Content Type drop-down menu, select Insert 
Content Using Document Variables.

 2. In the Component Name section, choose an option: 

 l Cube View Report

 l Excel Sheet

 l Excel Named Range

 l Microsoft Word Document

 3. The header and available fields in step 3 dynamically update based on your previous 

selection.
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 l For Cube View Report, the header displays as Cube View, and you can populate 

these fields: 

 o Cube View Group: The group containing the Cube View.

NOTE: The Cube View Groups displayed are defined by 

administrators when assigning Cube View Profiles. See Book 

Management.

 o Cube View Name: The name of the Cube View. All Cube Views associated 

with the Cube View Group are displayed.

 l For Excel Sheet, Excel Named Range, or Microsoft Word Document, the header 

displays with the respective selection. Complete these steps: 

 a. Click the Browse button.

 b. Use OneStream File Explorer to select a document from your files. When 

done, the Select a File text is replaced with the name of the file you chose.

 4. The header name dynamically updates based on your previous selections. For example, a 

Cube View selection in step 2 would display Cube View Settings in this step. 

Cube View Report and Excel Sheet selections enable you to select the Include Optional 

Settings checkbox. If you are not using Microsoft Word, select  Include Optional Settings 

to include additional formatting options with your parameters. Formatting options depend 

on the component you are inserting. In the following example for Cube View, additional 

setting options include headers, footers, or margins for the Cube View.
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Microsoft Word Example

Cube View Settings Example

 5. Copy the syntax from the Settings section and paste it into your document.

 6. Click the Process button to save and render the embedded content. The Process button is 

only supported in the Windows Application.

Click the Cancel button at any time to close the wizard.

Insert Content Using Office Image

Follow these steps in the wizard to embed content using images.
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 1. In the Artifact Selection section, from the Content Type drop-down menu, select Insert 
Content Using Office Image.

 2. In the Component Name section, choose an option: 

 l Cube View Report

 l Excel Sheet

 l Excel Named Range

 l PDF

 3. The header and available fields in step 3 dynamically update based on your previous 

selection.
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 l For Cube View Report, the header displays as Cube View, and you can populate 

these fields: 

 o Cube View Group: The group containing the Cube View.

NOTE: The Cube View Groups displayed are defined by 

administrators when creating Cube View Profiles. See Book 

Management.

 o Cube View Name: The name of the Cube View. All Cube Views associated 

with the Cube View Group are displayed.

 l For Excel Sheet, Excel Named Range, or PDF, the header displays with the 

respective selection. Complete these steps: 

 a. Click the Browse button.

 b. Use OneStream File Explorer to select a document from your files. When 

done, the Select a File text is replaced with the name of the file you chose.

 4. The header name dynamically updates based on your previous selections. For example, a 

Cube View selection in step 2 would display Cube View Settings in this step. 

Excel Sheet and PDF selections enable you to select the Include Optional Settings 

checkbox. Select  Include Optional Settings to include additional formatting options with 

your parameters. Formatting options depend on the component you are inserting. In the 

following example for PDFs, additional setting options include cropping options and 

borders.
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Include Optional Settings Enabled

Include Optional Settings Not 
Enabled

 5. Copy the syntax from the Settings section and  paste it into your document.

NOTE: Alt text images are not supported in the Modern Browser Experience.

NOTE: Syntax in PowerPoint documents must be embedded in images.  See 

"Using Images in Extensible Documents" in the Design and Reference Guide. 

 6. Click the Process button to save and render the embedded content. The Process button is 

only supported in the Windows Application.

Click the Cancel button at any time to close the wizard.

Reference Book Content

Follow these steps in the wizard to embed a business rule that references a standalone Excel 

Sheet or Excel Named Ranged in the same narrative book. Referencing the content ensures the 

embedded content updates alongside the source document and remains secure.
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 1. In the Artifact Selection section, from the Content Type drop-down menu, select 

Reference Book Content.

 2. In the Component Name section, choose an option: 

 l Excel Sheet

 l Excel Named Range

 3. In the Microsoft Excel section, from the Select a File: drop-down menu, choose your 

Microsoft Excel file or named range. The drop-down menu displays all the files you have 

access to in the current narrative book. 

 4. Copy the reference book syntax displayed below the Microsoft Excel Settings section 

and paste it into your document.

 5. Click the Process button to save and render the embedded content.
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Insert Parameter

Follow these steps in the wizard to embed an existing book or document parameter into your 

narrative document.

NOTE: Existing parameters are pulled from the parameter section in Book 

Management. See Book Management.

 1. In the Artifact Selection section, from the Content Type drop-down menu, select Insert 
Parameter.

 2. In the Parameter Type drop-down menu, select the type of parameter to insert: Book 

Parameter or Document Parameter.

 3. In the Parameter Selection, from the Parameter Name drop-down menu, select the 

parameter. The value of the selected parameter displays in the Parameter Value field.

 4. In Parameter Settings, copy and paste the syntax into your document.

 5. Click the Process button to save and view the rendered value.

Create Parameters

Follow these steps in the wizard to create a new parameter and save it to Book Management.

 1. In the Artifact Selection section, from the Content Type drop-down menu, select 

Create Parameter.

 2. In the Parameter Type drop-down menu, select the type of parameter to create: Book 

Parameter or Document Parameter.

 3. In the Parameter Selection section, add this information:
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 l Parameter Name: Enter a name for the parameter.

NOTE: Do not use special characters or dashes (-) in parameter names. 

For a list of restricted characters, see Dimension Member Names.

 l Parameter Value: Enter the value of the parameter.

 4. Click the Save button. Parameters are saved to the respective book or document in Book 

Management. To insert the parameter, see Insert Parameter.

Supported Extensible Content

Add additional extensible content outside of the Artifacts wizard. These types are supported. 

BI Viewer Chart Components

Use these steps to insert BI Viewer chart components into your document. 

 1. Go to Application > Workspaces >  Application Workspaces. 

 2. Click the Object Lookup button. 

 3. In the Object Lookup dialog box, in Object Types, select Extensible Document 
Settings. 

 4. Use the search filter or scroll to locate Insert Content Using Document Variables > 

BI Viewer Components.
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 5. Select the syntax and click the Copy to Clipboard button. 

 6. Return to your narrative document. 

 7. On the ribbon, go to the Insert tab > Quick Parts. 

 8. In the Doc Variable Name and Arguments dialog box, paste the syntax and update any 

variables.

Example: In this syntax, you will update the bolded text 

with the name of the BI Viewer component you want to 

display in your document: "{XF}{Application}{BIViewer}

{BIViewerComponentName}". 

 9. Click the OK button.

 10. Click the Save and Refresh button to view the component. 
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XFCell References 

XFCells enable you to pull the data from a specific cell and dynamically display it in narrative 

documents. XFCell can be added to narrative documents as a parameter in the following ways:

 l As a parameter in Book Management at the book or document level. 

 l As an application parameter, then inserted using Quick Parts. 

IMPORTANT: XFCell parameters cannot be added using the Artifact Wizard. Inserting it 

using the wizard auto-resolves the  XFCell value.

Book or Document Parameter

Insert an XFcell reference as a book or document parameter using these steps: 

 1. Go to Settings > Book Management. 

 2. For a book level parameter, enter the XFcell string into the Parameter field for the book, 

enclosing the string in brackets. For a document-level parameter, click the manage button 

to access the documents in the book. Enter the XFcell string into the Parameter field for the 

document in the book, enclosing the string in brackets. 

 3. Save your changes. 

 4. Open your narrative document. 

 5. On the ribbon, go to the Insert tab > Quick Parts. 

 6. In the Doc Variable Name and Arguments dialog box, paste the parameter value. 

IMPORTANT: After pasting, verify the parameter includes pipes and exclamation 

points. For example: |!BookParam!|.
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 7. Click the OK button.

 8. Click the Save and Refresh button to view your changes.

Application Parameter

 1. Add the XFCell as an application parameter. See Create a Parameter.

 2. Copy the syntax and navigate to your narrative document. 

 3. On the ribbon, go to the Insert tab > Quick Parts. 

 4. In the Doc Variable Name and Arguments dialog box, paste the parameter value. 

IMPORTANT: After pasting, verify the parameter includes pipes and exclamation 

points. For example: |!prm_Entity!|.

 5. Click the OK button.

 6. Click the Save and Refresh button to view your changes.

XFBR 

Add existing XFBR rules to narrative documents using Quick Parts.

 1. Go to Application > Tools >  Business Rules to locate the XFBR string you want to insert. 

 2. Copy the string and navigate back to the narrative document.

 3. On the ribbon, go to the Insert tab > Quick Parts. 

 4. In the Doc Variable Name and Arguments dialog box, paste the XFBR string. 

 5. Click the OK button. 

NOTE: The string is automatically modified to ensure the business rule run 
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correctly.

 6. Click the Save and Refresh button to view your changes.
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Publish Documents
From Narrative Reporting, publish documents for easy sharing by either creating a zip file or 

merging all documents into one file. Output of the publish tools is a processed version of the 

document.

Books and Documents with Parameters
Follow this guidance when using Zip and Merge: 

 l When parameters exist on a book, but not a document, parameters are applied to all 

documents in the book.

 l When parameters are in documents, but not in a book, parameters are applied to the 

specified document.

 l When parameters conflict between books and documents, book parameters are applied to 

all documents and the conflicting document parameters supersede the book parameters.

Zip
Download individual documents as a .zip file to view the documents on your local machine by 

using the Zip functionality. You can zip the following file types: 
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 l Microsoft Word

 l Microsoft PowerPoint

 l Microsoft Excel

 l PDF

To create a .zip file, follow these steps: 

 1. Select the book, section, or documents to be zipped.

 2. Under the Tree Navigation, click Zip.

Files are downloaded to your OneStream user folder.

Merge
Rather than downloading and sharing individual documents, you can download a merged version 

of a book or individual section using the merge feature. File types supported by the merge feature 

include Microsoft Word and PowerPoint.

NOTE: When your merge contains both PowerPoint and Microsoft Word documents, a 

file for each type will be generated; one contains all PowerPoint documents  and another 

contains all Microsoft Word documents. 

To create a merged version, follow these steps: 

 1. Select the book or section to merge.

 2. Under the Tree Navigation, click Merge.

Files are downloaded to your OneStream user folder.
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Help and Miscellaneous 
Information

Access the help documentation. 

Display Settings
OneStream Platform and Solutions frequently require the display of multiple data elements for 

proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of 

1920 x 1080 for optimal rendering of forms and reports.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming 

any of the elements contained in a package is discouraged in order to preserve the integrity of the 

naming conventions.

Example Package Name: NRR_PV9.1.0_SV100_PackageContents.zip

Identifier Description

NRR Solution ID

PV9.1.0 Minimum Platform version required to run solution
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Identifier Description

SV100 Solution version

PackageContents File name

Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom 

tables such as this one. The relationship between OneStream objects such as workflow profiles 

and custom solution tables is that they point to the underlying identifier numbers and not the 

object names as seen in the user interface. Prior to the solution configuration and to ensure the 

identifiers match within the development and production applications, the development 

application should be a recent copy of the production application. Once the development 

application is created, install the solution and begin design. The following process below will help 

migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.

 1. In the production OneStream application, install the solution and create the data tables. 

See Configure the OneStream Application Server for Database Server Connection settings 

and installation details.

 2. Data tables are created in the OneStream Development application during the solution 

installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to 

the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator 

should run the migration assistant.

IMPORTANT: This process has the potential to overwrite existing table data in the 

production application database if data already exists.
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OneStream Solution Modification 
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

 l Major changes to business rules or custom tables within a OneStream Solution will not be 

supported through normal channels as the resulting solution is significantly different from 

the core solution.

 l If changes are made to any dashboard object or business rule, consider renaming it or 

copying it to a new object first. This is important because if there is an upgrade to the 

OneStream Solution in the future and the customer applies the upgrade, this will overlay 

and wipe out the changes. This also applies when updating any of the standard reports and 

dashboards.

 l If modifications are made to a OneStream Solution, upgrading to later versions will be more 

complex depending on the degree of customization. Simple changes such as changing a 

logo or colors on a dashboard do not impact upgrades significantly. Making changes to the 

custom database tables and business rules, which should be avoided, will make an 

upgrade even more complicated.
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